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Overview 
 

Beginning with the 2017 NFL Pre-Season, the NFL’s Game Statistics & Information System (GSIS) stat entry program is 

moving from a client-server distributed architecture to a web-based architecture.  As such, there will be changes with 

respect to: 

 

1. How the stat crew accesses GSIS 

2. How in-stadium vendors and systems receive game stats and out of town scores 

3. How GSIS receives the game/play clock feed 

4. How Zebra receives the Clock and Situation feed from GSIS 

 

The high-level summary is that everything now communicates with the GSIS Web Environment instead of the in-stadium 

network (i.e., the ASA and Cisco switch). 

 

The infrastructure that has been in place at NFL stadiums to support GSIS and the dependent in-stadium systems and 

functionality will no longer be required.  The following infrastructure elements will now be retired: 

• The GSIS ASA and GSIS Cisco Switches 

• The backup POTS line 

• The GSIS Real-Time Stats Exporter 

• The direct in-stadium game/play clock feed to the GSIS laptops 

• The direct clock feed from the GSIS laptops to the Zebra servers 

 

Instead, all communication and data transport will go to and come from web services in the GSIS Web Environment.  

 

This guide will outline the requested in-stadium changes beginning with the 2017 NFL season and the technical 

specifications and requirements associated with those changes. 

  



 

GSIS Stadium Technician’s Guide V2.0 Date: 7/15/2019 Page 8 of 51 

 

 

7/15/2019                                             NFL Proprietary and Confidential      Page 8 

Theory of Operation 
The Game Statistics and Information System (GSIS) is a Windows-based tool that is used by the National Football League 

(NFL) to capture play-by-play game data at each NFL stadium for printing a game book and other reports for distribution 

to the media, and for use by the NFL clubs and League offices. 

This section includes the basic theory of operation of GSIS. 

Laptop Roles 
With legacy GSIS, there were two laptop roles: Primary and Secondary (i.e., Entry and Audit).  With GSIS Web, there is no 

longer this distinction between laptops.  A user’s rights within GSIS is determined by the user’s role defined in the 

system. 

User Roles 
There are two user roles in GSIS Web: Data Entry and Read-Only.   

Data Entry Role 
A user who is assigned the Data Entry User Role will be able to enter play information during a game, enter the Rosters, 

Depth Chart, Starters and Coaches in the Game Setup, and Close the game when the game is final and all data has been 

entered and verified. 

Read-Only Role 
Read-Only users can view the game stats only.  This role does not allow the user to modify any of the data in the system.  

GSIS Initialization 
 

Logging In 
Users of the system will be assigned unique login accounts. Their email address will be their login.  These will be Active 

Directory accounts provided by the NFL. Users will be authenticated via an ADFS login page. Rights and permissions in 

the system are tied to the user's account. 

Game Roster Generation 
A member of the stats crew will generate the rosters from the Game Setup screen.  The NFL updates rosters at 5pm and 

5am every day.  It is best to generate the rosters in GSIS after these times. For example, for a 1pm game, the rosters 

should not be generated until after the 5am job has run. For an 8:30, it is best to wait until the 5pm job has run. 
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Connectivity with the GSIS Cloud 
Connectivity to the GSIS cloud will be provided by the stadium via a hard wire Ethernet cable. The Wi-Fi network will be 

disabled on the GSIS laptops.  In the event there is an issue with the stadium provided internet, two Verizon USB Cellular 

modems are being provided to allow the Entry and Audit laptops to connect and continue stat entry. 

 

GSIS Data Flow 
The stat crew enters game play data into the GSIS Website.  As plays are ended or ended plays are edited, files are 

generated for consumption by broadcast partners, in-stadium vendors, and the officially licensed stats distributor. 

In-stadium vendors will use the new GSIS Data Interface to receive the files as they are generated. 

The Game and Play Clock is transmitted to the GSIS Cloud from either the Daktronics DSTI, or another in-stadium server 

which is receiving the clock ticks from Daktronics or OES. 
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Initial System Configuration and Testing 
This chapter includes one-time procedures that must be performed before using the system. These procedures should 

not have to be repeated but be aware that you may need to execute them prior to a game. 

Laptop Network Settings 
With the 2017 season move to the web, GSIS laptops will now use an IP address obtained automatically by the stadium 

network. 

Disable Wi-Fi Network Adapter 
Because Wi-Fi is less reliable than a hard wire Ethernet connection, we will disable the Wi-Fi Network Adapter on each 

GSIS laptop. 

1. Log on to one of the laptops as Club-Admin 

2. Open the Network and Sharing Center from the Control Panel 

3. Click “Change Adapter Settings” 

4. Right-click the “Wireless Network Connection” 

5. If the connection is enabled, click “Disable” 

 

 

Obtain an IP Address Automatically 
To use the Stadium Internet, we will need to change the GSIS laptops from a Static IP Address to instead obtain an IP 

Address automatically (Unless your stadium is assigning static IP addresses): 

1. Log on to one of the laptops as Club-Admin 

2. Open the Network and Sharing Center from the Control Panel 

3. Click “Change Adapter Settings” 
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4. Right-click the “Local Area Connection” and open the Properties. 

 

1. Select the “IPv4” connection and click the Properties button. 

2. Select the radio button for “Obtain an IP address automatically”  

3. Select the radio button for “Obtain DNS server address automatically” 

4. Click OK. 
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Default Browser 
GSIS is a web-based application.  The primary Web Browser to use with GSIS is Google Chrome.  It is important to set the 

default browser on the laptop to be Google Chrome instead of Internet Explorer. 

Important: this setting is user specific. 

1. Log on to a laptop as Club-User 

2. Open the Control Panel and in the Search box type “Default Programs” 

3. Select Default Programs from the search results list: 

 
 

4. Click on the “Set Your Default Programs” link 

5. Select “Google Chrome” from the list on the left 
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6. Click on the “Set this program as default” button 

 

 

When successfully completed, it should read, “This program has all its defaults” just above the “Set this program as 

default” button. 
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Desktop Shortcuts 
There are three important websites that we will create Desktop Shortcuts for: 

• https://entry.nflgsis.com – This is the main GSIS website for the Entry and Audit operators.   

• http://www.nflgsis.com – This is the Live Stats site 

• http://support.nfl.net – This is the website we will use for Remote Desktop connectivity when trouble-shooting 

Use the following URLs and Names when creating the shortcuts: 

Shortcut URL Shortcut Name 

https://entry.nflgsis.com GSIS 

http://www.nflgsis.com Live Stats 

http://support.nfl.net Support 

 

Create a Google Chrome App Mode desktop shortcut 
It is important to create the GSIS desktop shortcut from within Google Chrome so that it will open in Google Chrome 

App Mode.  This will open GSIS without any toolbars or menu bars and will allow the stat crew to hit the F11 key to 

capture the Game/Play clock value without exiting full screen mode.  The other two shortcuts can be created as regular 

desktop shortcuts. 

Important: this step is user specific. 

1. Open Google Chrome and navigate to https://entry.nflgsis.com 

2. Enter credentials to authenticate when prompted 

3. In the Chrome settings under “More tools” click “Create Shortcut…” 
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4. When the following prompt shows up.  Type the shortcut name as “GSIS” and select “Open as window”.  Click 

Add. 

 
 

5. Now move the newly created GSIS shortcut from your desktop to the public desktop folder so that it will appear 

for all users.  The Public Desktop folder is located at: “c:\users\public\public desktop” 

6. If you launch GSIS from the new shortcut, you will see that it will launch in App Mode. 

 

Create a regular desktop shortcut 
The following method can be used to create desktop shortcuts for NFLGSIS.com and NFL Support. 

Important: this step is user specific. 

1. Log on to a laptop as Club-User 

2. Right click on the desktop.  Select New > Shortcut. 
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3. Enter the URL: 

 
 

4. Enter the Shortcut Name: 

 
 

5. Click the Finish button. 

When finished, you should have the following three shortcuts: 
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If the icon is not Google Chrome, you need to set the Default Browser to Google Chrome.  See the previous section on 

setting the default browser. 
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Test Internet Connectivity 
Double-click on each shortcut created in the previous section to ensure that Internet connectivity is functioning 

properly. 

Entry.nflgsis.com (note: you will initially be prompted to authenticate with your GSIS credentials): 
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www.nflgsis.com: 

 

 

Support.nflgsis.com: 
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USB Cellular Modems 
Two Verizon USB Cellular Modems are being provided to each club.  These modems will be used by the Entry and Audit 

operators if Stadium Internet connectivity is lost.  If Stadium Internet connectivity is functioning properly, these modems 

should NOT be used and should not be connected to the laptop but should be within arm’s reach. 

To test the USB Cellular Modem: 

1. Log on to a laptop as Club-User 

2. Unplug the Ethernet cable from the laptop 

3. Double-click on the Live Stats desktop shortcut and ensure the laptop does not have Internet connectivity. 

4. Plug the USB Cellular Modem into a USB port on the laptop 

5. Connect the modem to the internet 

6. Double-click on the Live Stats desktop shortcut to ensure the laptop has Internet connectivity. 

7. Unplug the modem from the USB port 

8. Plug the Ethernet cable back into the laptop 

9. Double-click on the Live Stats desktop shortcut to ensure the laptop has Internet connectivity. 
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Browser Full Screen Mode 
The GSIS users may wish to use the browser’s Full Screen mode when using GSIS.  The keystroke for Full Screen in 

Google Chrome and Internet Explorer is F11.  However, since F11 is used in GSIS to capture the Game Clock, the users 

will need to use the mouse to enter and exit Full Screen mode while in GSIS. 

Note: F11 will work if the user is not in the GSIS Entry screen.  For example, a user could go to the Game Setup screen, 

click F11 to enter Full Screen mode, and then return to the Stat Entry screen. 

Google Chrome 
Full screen mode in Google Chrome should be accessed by using the GSIS desktop shortcut.  This short cut should have 

been created from within Google Chrome as instructed in the Desktop Shortcuts section. 

If a user accesses GSIS by simply navigating to the URL and then clicking F11 to enter Full screen mode, the user will be 

taken out of full screen mode when they hit the F11 key to capture the Game/Play clock.  This issue does not occur when 

using the App Mode desktop shortcut for GSIS. 

Internet Explorer 
To enter full Screen mode in Internet Explorer: 

1. Click on the Tools button 

 
 

2. Select File > Full Screen 

 

To exit Full Screen mode in Internet Explorer: 

1. Right click on the Stat Entry screen and the Internet Explorer menu bar will appear at the top of the screen. 

2. Click on the Tools button 

3. Select File > Full Screen 

 

  



 

GSIS Stadium Technician’s Guide V2.0 Date: 7/15/2019 Page 22 of 51 

 

 

7/15/2019                                             NFL Proprietary and Confidential      Page 22 

Change Time Zone and Update the Time 
For the Start Time of Day on each play to display in the local time zone, please ensure your time zones are set correctly 

for your location.  If the Start Time of Day needs to be entered or edited manually, this will also be important. 

Set the Time Zone 
1. Search for “Change the Date and Time” 

2. From the Time Zone drop-down, select your time zone. 

Update the Time 
1. From the Date & Time settings screen from the prior step, deselect “Set Time Automatically”, and then select it 

again.  This should cause the laptop to sync to the accurate time.  (This is important when you first receive the 

laptops from the League Office) 

 

Windows Updates 
With the move of GSIS to the web, it will be important to apply Windows Updates to ensure the laptops are securely 

patched.  Since we do not want the laptops to start applying the updates during a game, the Stadium Technician must 

apply the latest updates either before the stat crew enters the rosters, or after the game has been closed. 

Windows Updates Settings 
1. Log on as Club-Admin 

2. Search for “Windows Update settings” 

3. If you have an active internet connection, Windows may start checking for updates depending on how long it’s been 

since the last check. 

4. If Windows doesn’t check automatically, you can click the Check for Updates button. 

5. If you have time, you should allow the computer to apply updates.  Click the Install Updates button. 

6. However, if your stat crew needs to begin working, then you’ll need to pause updates, and then apply the updates 

after the game is over.  

7. To Pause Updates click on the Advanced Options link, then click on the Pause Updates button. 

Note: once you resume updates, Windows will check for updated immediately and start installing them, so don’t un-

pause until you’re ready. 

8. Active Hours are set to: 11 AM to 3 AM.  Windows will not automatically restart during this time and won’t restart 

without first notifying you. 
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Laptop Printer Configuration 
Each laptop must be set up to print to the network printer. 

Note: the previous instructions for installing and configuring the printer are included in the Appendix. However, these 

most likely no longer apply as they assumed using the GSIS Private Network.   

Please work with the stadium IT team if needed to network the printer. 

Install the printer on each laptop and set it as the default printer. 
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Stats in a Box Servers 
The Stats in a Box (SIAB) servers will now need internet access and will run the NEW GSIS Data Interface to receive data 

updates.  (Note: Stats in a Box servers used the old GSIS Data Interface to previously receive data). 

1. Install the latest GSIS Data Interface from http://www.nflgsis.com/gsisupdate and register the production and 

test versions with the GSIS-[Club Initials] device account provided by the NFL. 

2. Open Stats in a Box and accept any Adobe Air updates that the software wants to run. 

 
3. Open the production GSIS Data Interface using the shortcut on the desktop. 

4. If you have not done so already, you will need to enter the data path in the Settings dialog box.   

a. If this is the first time starting the GSIS Data Interface, the Settings dialog box will open automatically. 

b. The Settings dialog box can also be accessed from the View menu. 

5. Click the “…” button for the Local Save Path: 

 
6. Navigate to the location where Stats in a Box is expecting the files to be located.  This is usually C:\GSISData. 

a. This value can be verified in the Settings of Stats in a Box 

7. Select an historical game and verify that Stats in a Box changes to the selected game in the Title Bar at the top. 

8. Use the GSIS Data Interface to click through a few plays of the selected historical game and verify that the plays 

are available from the Plays section of Stats in a Box. 

9. Close the production GSIS Data Interface and open the Test GSIS Data Interface (from Start > All Programs > NFL 

> GSIS Data Interface program). 

a. You’ll need to contact GSIS Support to start a test game in GSIS Web.  877-635-0171 or 

GSISTechSupport@nfl.com. 
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10. Select the test game indicated by the GSIS Support team 

11. The Title Bar of Stats in a Box should change to the selected game. 

12. Plays should become available in the Plays section as plays are entered into GSIS Web. 
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GSIS Pre-Season System Tests 
You should test each laptop prior to the first pre-season home game. Obtaining successful results from the following 

procedures will most likely result in a fully operational system. 

Communicate with the League Office – 1 
Let us know the day and time you are planning to perform your stadium check, so we can try to be available to assist if 

needed. 

Time 
Check that the laptop local time is accurate 

Windows Updates 
Ensure all available Windows Updates have been successfully applied. 

Internet Connectivity to GSIS Sites 
Test that each port to which a GSIS laptop will be connected has internet connectivity to the GSIS sites.  This is important 

as stadium firewalls can sometimes block access to GSIS. 

Double click on the three desktop shortcuts: 

• Live Stats: You should be able to get to the login page for www.nflgsis.com. 

• GSIS: Log in to https://entry.nflgsis.com to make sure the Admin Console loads properly. 

• GSIS Remote Support: Navigate to http://support.nfl.net to ensure the page loads successfully. 

Printing 
Log in to www.nflgsis.com. 

Navigate to week 17 of last season. 

Click on the Hamburger menu and select the Game Summary report for your week 17 game. 
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Print the report.  The report should print successfully through the networked GSIS Printer. 

 

USB Cell Modem 
Test that the USB cell modems provided by the NFL are able to provide internet connectivity to the Entry and Audit 

laptops in the event of a stadium internet outage. 

1. Disconnect the Ethernet cable from the entry and audit laptops. 

2. Plug the USB Cell Modem into the laptop. 

3. After a short period of the modem establishing connectivity, it should display a green light you should be able to 

navigate to https://entry.nflgsis.com.   

4. https://entry.nflgsis.com should fully load and display the current week’s list of games. 

5. Take a photo or screen grab of the Entry and Audit Laptops connected via the USB Cell Modem and post it to the 

WhatsApp group.  You must use the MyUSB screen that shows the USB Cell Modem is successfully connected. 
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Stats in a Box and the GSIS Data Interface 
If you operate Stats In A Box for your In-House Stats channel, follow these steps: 

1. Open Stats in a Box and accept any Adobe Air updates that the software wants to run. 

 
2. Open the production GSIS Data Interface using the shortcut on the desktop. 

3. Select an historical game and verify that Stats in a Box changes to the selected game in the Title Bar at the top. 

4. Use the GSIS Data Interface to click through a few plays of the selected historical game and verify that the plays 

are available from the Plays section of Stats in a Box. 

5. Close the production GSIS Data Interface and open the Test GSIS Data Interface (from Start > All Programs > NFL 

> GSIS Data Interface program). 

a. You’ll need to contact GSIS Support to start a test game in GSIS Web.  877-635-0171 or 

GSISTechSupport@nfl.com. 

6. Select the test game indicated by the GSIS Support team 

7. The Title Bar of Stats in a Box should change to the selected game. 

8. Plays should become available in the Plays section as plays are entered into GSIS Web. 

Communicate with the League Office – 2 
Let us know when your stadium check is complete and that everything was successful, or if you have any notes or issues. 
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Game Day Procedures 
This chapter contains procedures and tests for setting up GSIS on game day.   

Communicate with the League Office - 1 
Let the League Office know that you are in the stadium by posting a message in the WhatsApp. 

Setting up the Game Day Environment 
Setting up the game day environment consists of the following: Setting up the Laptops, Testing Internet Connectivity; 

Verify Ticking Clock; Test printing; Test USB Modem;  

Set Up the Laptops 
• Connect each laptop to the network with an Ethernet cable. 

• Power up each laptop and log in to the operating system. 

 

Time 
Check that the laptop local time is accurate 

Test Internet Connectivity to NFL/GSIS Sites 
Verify that the three desktop shortcuts work as expected: 

• The GSIS Remote Support (https://support.nfl.net) shortcut should take you to the Support Portal. 

• The Live Stats (http://www.nflgsis.com) shortcut should take you to the login screen of www.NFLGSIS.com.   

o You can log in with a username of [teamname]-PR and a password of [teamname].  (i.e. Dolphins-PR and 

dolphins). 

• The GSIS (https://entry.nflgsis.com) shortcut should prompt you to log in.  Enter your credentials.  You should be 

taken to the current week’s set of games.  Find your game and click on the “GSIS” button to enter the game.   

Verify the clock is ticking 
• Check that the stadium game clock is displaying in the game.  If it is not, reach out to the clock operator to make 

sure they’ve started the GSIS Clock Transmitter.  If they are having issues, call GSIS Support at 877-635-0171. 
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Test Printing 
Log in to www.nflgsis.com using the Live Stats desktop shortcut. 

Navigate to a prior week game. 

Click on the Hamburger menu and select the Game Summary report for the game. 

 

Print the report.  The report should print successfully through the networked GSIS Printer. 

Test the USB Cell Modem 
• Disconnect the Ethernet cable from the Entry and Audit laptops. 

• Make sure the Wifi adapter is disabled. 

• Plug in the USB Cell Modem (note: it can take a couple of minutes for the cell modem to establish connectivity) 

• Take a photo or screen grab of the Entry and Audit Laptops connected via the USB Cell Modem and post it to the 

WhatsApp group.  You must use the MyUSB screen that shows the USB Cell Modem is successfully connected. 

• Open the web browser and navigate to www.nflgsis.com.  Ensure that the page can load with just the USB cell 

modem for connectivity. 

• Disconnect the USB Cell Modem and plug the Ethernet cable back into the laptops.  Again, ensure you have 

internet connectivity. 

Windows Updates 
Ensure all available Windows Updates have been successfully applied or pause updates if needed and apply them after 

the game. 
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Stats in a Box 
You may be responsible for running Stats in a Box on the In-house TV system. 

• Connect to the Stats in a Box server. 

• Start the GSIS Data Interface.  Open it by SHIFT+Right-Clicking on the GSIS Data Interface icon on the desktop 

and selecting “Run as Administrator”. 

• Open the GSIS Graphics System. 

• Note: you will not receive the game until the stat crew has finished fixing the rosters and the GAME play has 

been ended in GSIS.  This will usually occur about one hour prior to kickoff. 

• Once the GAME play has been ended, the GSIS Data Interface will display the teams and the GameKey in its UI.  

Check that the GSIS Graphics System shows the same.  If not, click the Roster button and the Game to Date 

button in the GSIS Data Interface. 

Communicate with the League Office - 2 
In the WhatsApp group, let the League Office know that your game day checks are successfully completed and post a 

picture of the USB Cell Modem page with a Connected status for both the Entry and Audit laptops. 

Communicate with the League Office – 3 
When you’re done for the day and have left the stadium, let the League Office know by posting a message in the 

WhatsApp group. 
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Appendix 
The following is the GSIS Stadium Guide that was provided to Club IT Executives, Club IT Directors, Stadium Personnel 

and Stadium Vendors to prepare them for the GSIS changes for the 2017 season.  It is provided in this appendix as a 

reference of the changes that have been requested by the NFL. 

Summary of In-Stadium Changes/Requests 
Stats Booth 

• Re-patch GSIS laptop and GSIS printer Ethernet connections from ports 1-17 of GSIS Cisco switch to Stadium 

Internet. 

• Provide one or two phones in stats booth for stat crew and GSIS tech if possible. 

• Connect the GSIS printer as a network printer that the GSIS laptops can print to. 

GSIS Clock Transmitter 

• If Daktronics 

o Install GSIS Clock Transmitter on DSTI 

o Ensure DSTI has Internet access 

• If OES 

o Re-configure OES controller to send clock feed to a Windows-based server/device with Internet access 

instead of sending to GSIS network (172.16.x.255).  Suggestion is to send to a Stats in a Box server that 

has Internet access. 

o Install the GSIS Clock Transmitter on the Windows-based server/device identified in the previous bullet. 

GSIS Data Interface 

Note: the GSIS Data Interface replaces the functionality of the GSIS Real-Time Stats Exporter 

• Install the GSIS Data Interface on Windows-based servers/devices that previously received in-stadium game 

stats and out-of-town scores from the GSIS Real-Time Stats Exporter. 

• Ensure the Windows-based servers/devices have Internet access OR have access to another server/device 

running the GSIS Data Interface that has Internet access. 

Stats in a Box 

• Install the new GSIS Data Interface on any Stats in a Box servers in use at the stadium. 

• Ensure all Stats in a Box servers have Internet access OR have access to another server/device running the GSIS 

Data Interface that has Internet access. 

GSIS Clock and Situation Feed (Zebra/NGS) 

• Zebra server requires Internet access (if it does not already have it) 

 

Stats Booth / Press Box 
The Stats Booth is the location where the stats crew will enter the game play data into the GSIS system.  In many cases 

this is a dedicated booth in the stadium, however this can also be a group of seats in the Press Box or any other location 

as deemed appropriate by the Club PR department. 
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Many of the Ethernet ports in the Stats booth will have previously been wired to ports 1-17 of the GSIS Cisco Switch.  

These may have been used for: GSIS Laptops, GSIS IP Phone or a GSIS Printer. 

 

GSIS Laptops 

Prior to 2017 Season 

In past seasons, the GSIS laptops have been connected to the GSIS Cisco Switch and configured with static IP addresses.  

They accessed www.nflgsis.com via the GSIS Cisco ASA that was provided to each stadium. 

2017 Season 

GSIS laptops should now be connected to a stadium VLAN which will need to provide Internet access.  The stat crew will 

use Chrome and Internet Explorer 11 to access the GSIS Web Entry application.   

Instead of the static IP address that was previously used with the GSIS Network, GSIS laptops should now receive an IP 

address via DHCP from the Stadium VLAN. 

Requested Stadium Changes 

• Re-patch GSIS laptop Ethernet connections from ports 1-17 of GSIS Cisco switch to Stadium Internet. 

 

GSIS IP Phone 

Prior to 2017 Season 

The NFL previously provided an IP phone that was connected to the GSIS Network.   

2017 Season 

With the removal of the GSIS network for the 2017 season, the GSIS IP Phone will be retired.  In its place, a stadium 

phone should be provided for the stat crew and ideally for the GSIS Stadium Tech as well. 

Requested Stadium Changes 

• Provide one or two phones in stats booth. One for stat crew and one for GSIS tech, if possible. 

  

GSIS Printer 

Prior to 2017 Season 

The GSIS laptops print to a GSIS Printer for verifying the stats during the game and providing stats to PR for printing and 

distribution.  The GSIS Printer was previously a networked printer on the GSIS Network with a static IP address.   

2017 Season 

The GSIS Printer should now be a networked printer on the same Stadium Network that the GSIS Laptops can print to. 

Requested Stadium Changes 

• Add the GSIS Printer as a network printer that the GSIS laptops can print to. 
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POTS (Dial-Up) Line 

Prior to 2017 Season 

Backup connectivity for the legacy GSIS system was a POTS (dial-up) line that the Primary GSIS laptop would connect to 

via a USB modem. 

2017 Season 

The POTS line will no longer be used beginning with the 2017 Season. 

Requested Stadium Changes 

N/A 

 

DVR 

Prior to 2017 Season 

Some stadiums use the NFL Vision DVR software to allow the stat crew to review plays with DVR functionality.  This 

might be provided via an in-stadium IPTV system, or it may be provided via a Coax cable connected to a GSIS laptop 

using a USB tuner. 

2017 Season 

The changes to GSIS for the 2017 season do not affect the use of NFL Vision DVR for the stat crew 

Requested Stadium Changes 

No changes are needed.  It is important to note that if an Ethernet port is used to provide the video feed to a GSIS 

laptop, that Ethernet port should not be changed as part of the re-patching required for the GSIS laptops mentioned 

above. 

 

PR Home and PR Visit Locations 

Prior to 2017 Season 

Previously, a GSIS laptop would be set out at the PR Home and PR Visit locations in the press box, where each Club’s 

Public Relations personnel were seated.   

2017 Season 

Beginning with the 2017 Season, Public Relations personnel will use the Game Stats Live feature of www.nflgsis.com to 

follow the stats associated with the game.  Game Stats Live is designed to work on all platforms and devices. 

Requested Stadium Changes 

N/A 

 

In-Stadium Printer 

Prior to 2017 Season 

Some stadiums have allowed the GSIS laptops to print directly to an in-stadium printer in addition to the GSIS Printer.   



 

GSIS Stadium Technician’s Guide V2.0 Date: 7/15/2019 Page 35 of 51 

 

 

7/15/2019                                             NFL Proprietary and Confidential      Page 35 

2017 Season 

With moving the GSIS laptops to a stadium LAN segment, the GSIS laptops would need the ability to map and print to 

the in-stadium printer. 

Requested Stadium Changes 

• Provide the ability for the GSIS laptops to print to the in-stadium printer from the stadium LAN segment the GSIS 

laptops are a member of. 
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GSIS Clock Transmitter 
The GSIS Clock Transmitter is a .NET desktop client app that will receive the game clock via UDP port 21300 and send 

that feed to the GSIS Cloud via the Internet. 

The GSIS Clock Transmitter requires .NET Framework version 4.5.  If the host server does not currently have the version 

of the .NET Framework installed, the GSIS Clock Transmitter Installer will install it. 

Currently, the Game Clock is provided by one of two providers in-stadium: Daktronics or OES.   

Daktronics 

Prior to 2017 Season 

The Daktronics DSTI sent the Game Clock feed directly to the GSIS Network. 

2017 Season 

The GSIS Clock Transmitter will be installed and run on the Daktronics DSTI server. 

Note: it is important that the DSTI server has had its Operating System upgraded to Windows 7.  If your DSTI server is 

still Windows XP, please contact GSIS Support immediately at 877-635-0171 or GSISSupport@nfl.com. 

The DSTI server needs access to the Internet to allow the GSIS Clock Transmitter to send the clock to GSIS. 

The Daktronics operator should remove the 172.16.x.255 IP address from the “Network Clock IP Addresses” dialog box 

on the primary and backup DSTI machines: 

 

Requested Stadium Changes 

• Install GSIS Clock Transmitter on DSTI 

• Ensure DSTI has Internet access 

 

OES 
As of the 2017 Pre-season, the following seven stadiums were using OES for their clock feed: BUF, CHI, DAL, GB, PHI, 

SEA, TEN. 
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Prior to 2017 Season 

The OES Controller sent the clock feed directly to the GSIS network via UDP 21300. 

2017 Season 

Since the GSIS Network will no longer exist beginning with the 2017 season, the OES Controller will need a new target 

system to send the clock feed to.  The GSIS Clock Transmitter will be installed on this target system, and the system will 

need Internet access to allow the GSIS Clock Transmitter to send the clock to GSIS.   

A good target candidate is one of the Stats in a Box (SIAB) servers that service either the Scoreboard or the in-house TV 

network.  Alternately, any windows-based server that can receive the UDP feed from the OES Controller and has 

Internet access can work.   

Requested Stadium Changes 

• Re-configure OES controller to send clock feed to a Windows-based server/device with Internet access instead 

of sending to GSIS network (172.16.x.255).  Suggestion is to send to a Stats in a Box server that has Internet 

access. 

• Install the GSIS Clock Transmitter on the Windows-based server/device identified in the previous bullet. 
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GSIS Data Interface 
Prior to 2017 Season 

System that needed in-game statistics and out of town scores would receive them over the GSIS Network from the GSIS 

Real-Time Stats Exporter. 

2017 Season 

The GSIS Data Interface is a .NET desktop client app that will provide in-game statistics and out of town scores in a 

similar manner that the GSIS Real-Time Stats Exporter used to.  However, instead of receiving data from a GSIS laptop on 

the GSIS network, the GSIS data will now be received over the Internet. 

In most cases, the GSIS Data Interface will simply run on any Windows based server or computer that requires GSIS data 

to be retrieved from the web.  The files can be downloaded to a local folder and/or sent to a local or remote MSMQ 

queue. 

The GSIS Data Interface client app can also be used to receive the files from another GSIS Data Interface running on 

another server.  This might occur if the receiving server does not have Internet access, but the sending server does have 

Internet access.  This configuration requires TCP 1801 open between the two windows systems for MSMQ (Microsoft 

Message Queue). 

The GSIS Data Interface app requires .NET Version 4.5 to be installed on the server.  If .NET Version 4.5 is not currently 

installed, the GSIS Data Interface setup will install it.   

To receive the data from the GSIS Web, the server running the GSIS Data Interface app will also need Internet 

connectivity. 

Data Files that will be delivered via the GSIS Data Interface include: 

• GSISGameStats.xml 

• Roster.xml 

• Scores.xml 

• Leaders.xml 

• IndividualLeaders.xml 

• [HHH]_SeasonToDateStats.xml (where HHH is the Club Code for the home team) 

• [VVV]_SeasonToDateStats.xml (where VVV is the club Code for the visiting team) 

• TeamRankings.xml 

Typical systems that will use the GSIS Data Interface to receive GSIS Data files include (but not limited to): 

• Daktronics DSTI 

• Click Effects / ChyronHego 

• Stats in a Box 

• Ross XPression 

Any system that previously received the in-stadium data feed from the GSIS Real-Time Stats Exporter should now use 

the GSIS Data Interface to retrieve the data. 
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Requested Stadium Changes 

• Install the GSIS Data Interface on Windows-based servers/devices that previously received in-stadium game 

stats and out-of-town scores from the GSIS Real-Time Stats Exporter. 

• Ensure the Windows-based servers/devices have Internet access OR have access to another server/device 

running the GSIS Data Interface that has Internet access. 
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Stats in a Box 
Stats in a Box (SIAB) is a system developed by the NFL League Office to display in-game statistics and out of town scores 

and leaders in a compelling digital display format.  The Stats in a Box system may be used to display graphics to the 

stadium scoreboard and ribbons, or to an in-house, or both.  Therefore, stadiums which host NFL games may be using 

two, one or zero Stats in a Box servers.   

Prior to 2017 Season 

The Stats in a Box servers had previously run an earlier generation of the GSIS Data Interface which would receive the 

GSIS data files from either the Internet or the in-stadium GSIS Real-time Stats Exporter.  However, sometimes the SIAB 

servers do not have an Internet connection and therefore relied completely on the GSIS Real-time Stats Exporter.   

2017 Season 

Beginning with the 2017 season, the Stats in a Box servers will either need an Internet connection, or will need to 

receive the data files from another server with Internet access that is running the GSIS Data Interface (requires MSMQ – 

TCP 1801 open between the servers).  Usually the SIAB server that feeds the scoreboard and ribbons has Internet access 

(although not in all cases), and usually the SIAB server that feeds the in-house TV system does not have Internet access.  

 Requested Stadium Changes 

• Install the new GSIS Data Interface on any Stats in a Box servers in use at the stadium. 

• Ensure all Stats in a Box servers have Internet access OR have access to another server/device running the GSIS 

Data Interface that has Internet access. 
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GSIS Clock and Situation Feed (Zebra / Next Gen Stats) 
Prior to 2017 Season 

Beginning with the 2015 season, GSIS provided the Game/Play Clock and Situation (down/dist/yards, etc) feed to Zebra 

via the GSIS Network, to which the Zebra network connected to via a Layer-2 connection.   

2017 Season 

The GSIS network will no longer exist starting in 2017, and Zebra will now pull this feed directly from a GSIS Web Service.  

Internet access for the Zebra servers will now be required (if this was not already the case). 

Requested Stadium Changes 

• Zebra server requires Internet access (if this is not already the case) 
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Stadium Changes Punch List 
 

  

Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

GSIS Laptop • Static IP Address 

• GSIS Cisco Switch Ports 1-17 

• Could access www.nflgsis.com 

via the GSIS Network 

• DHCP 

• Stadium VLAN 

• Will need Internet access  

• Re-patch GSIS laptop Ethernet 

connections from ports 1-17 of 

GSIS Cisco switch to Stadium 

Internet. 

GSIS IP Phone • GSIS Cisco Switch Ports 1-17 

• OR 

• GSIS ASA Port 7 

• Stadium supplied phone. 

• Ideally, one (1) for stats crew and 

one (1) for GSIS Stadium Tech 

• Provide one or two phones in 

stats booth. One for stat crew 

and one for GSIS tech, if possible 

GSIS Printer • GSIS Cisco Switch Ports 1-17 • Set up as a Network Printer on the 

same Stadium VLAN as the GSIS 

Laptops.   

• Does not require Internet access, 

however. 

• Add the GSIS Printer as a network 

printer that the GSIS laptops can 

print to 

POTS line • Dial-up line used as a backup 

connection to the GSIS Network 

• No longer used. • N/A 

DVR • May connect to an in-house 

IPTV system in some stadiums 

• No change. 

• This is not affected by the GSIS 

system changes. 

• No changes are needed.  It is 

important to note that if an 

Ethernet port is used to provide 

the video feed to a GSIS laptop, 

that Ethernet port should not be 

changed as part of the re-

patching required for the GSIS 

laptops mentioned above. 

 

Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

PR Home and PR Visit 

Laptops 

• GSIS Cisco Switch Ports 1-17 • Stadium Internet. 

• PR personnel will use 

www.nflgsis.com going forward. 

• N/A 
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Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

Game and Play Clock 

Feed to NFL (Daktronics 

DSTI) 

• Provided via UDP 21300 from 

the Daktronics DSTI to the GSIS 

Network: 172.16.x.255 

• The GSIS Clock Transmitter will run 

on the Primary and Backup DSTI 

servers 

• Will require Internet connectivity 

to send the clock feed to GSIS 

• DSTI will require .NET Framework 

version 4.5.  The GSIS Clock 

Transmitter installer will install this 

framework if it does not already 

exist. 

• Install GSIS Clock Transmitter on 

DSTI 

• Ensure DSTI has Internet access 

 

Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

Game and Play Clock 

Feed to NFL (OES 

Controller) 

• Provided via UDP 21300 from 

the OES Controller to the GSIS 

Network: 172.16.x.255 

• The OES Controller will send the 

UDP 21300 clock feed to a 

Windows based target host server.  

A Stats in a Box (SIAB) server 

maybe be a good host server 

candidate. 

• The Host Server will require 

Internet connectivity to send the 

clock feed to *.nflgsis.com 

• The host server will require .NET 

Framework version 4.5.  The GSIS 

Clock Transmitter installer will 

install this framework if it does not 

already exist. 

• Re-configure OES controller to 

send clock feed to a Windows-

based server/device with 

Internet access instead of 

sending to GSIS network 

(172.16.x.255).  Suggestion is to 

send to a Stats in a Box server 

that has Internet access. 

• Install the GSIS Clock Transmitter 

on the Windows-based 

server/device identified in the 

previous bullet. 
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Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

Dependent Systems 

which consume the in-

game stats and out of 

town scores data 

• In-game stats and out of town 

scores were provided by the 

GSIS Real-Time Stats Exporter 

from a GSIS laptop on the GSIS 

network 

• Systems that depend on game 

stats and out of town scores will 

need to install the GSIS Data 

Interface desktop app  

• The dependent system will require 

Internet connectivity to receive 

the data files from *.nflgsis.com 

• The dependent system will require 

.NET Framework version 4.5.  The 

GSIS Data Interface setup will 

install the framework if it does not 

already exist. 

• Install the GSIS Data Interface on 

Windows-based servers/devices 

that previously received in-

stadium game stats and out-of-

town scores from the GSIS Real-

Time Stats Exporter. 

• Ensure the Windows-based 

servers/devices have Internet 

access OR have access to another 

server/device running the GSIS 

Data Interface that has Internet 

access. 

 

Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

Stats in a Box Servers • Ran an earlier version of the 

GSIS Data Interface to download 

Stats and Scores/Leaders from 

the Internet or to receive these 

data files from the GSIS Real-

Time Stats Exporter. 

• In some cases these servers had 

Internet access (usually for the 

scoreboard/ribbon displays), but 

not in all cases (in-house TV 

usually did not have Internet 

access). 

• The Stats in a Box servers  will 

require Internet connectivity to 

receive the data files from 

*.nflgsis.com 

• Alternately, the SIAB servers can 

receive the data files from another 

server running the GSIS Data 

Interface app that has Internet 

connectivity.  Requires MSMQ 

(TCP 1801) open from sending 

server to receiving server. 

• The dependent system will require 

.NET Framework version 4.5.  The 

GSIS Data Interface setup will 

install the framework if it does not 

already exist. 

• Install the new GSIS Data 

Interface on any Stats in a Box 

servers in use at the stadium. 

• Ensure all Stats in a Box servers 

have Internet access OR have 

access to another server/device 

running the GSIS Data Interface 

that has Internet access 
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Device Prior to 2017 Season 2017 Season Requested Stadium Changes 

Zebra connection for 

GSIS Clock and Situation 

• The feed was provided over 

UDP 50000 to Zebra via the 

GSIS Network 

• Zebra will now consume this feed 

from a GSIS Web service. 

• Internet access to *.nflgsis.com 

will be required from the device(s) 

that Zebra uses to authenticate 

and consume the feed. 

• Zebra server requires Internet 

access (if this is not already the 

case) 
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Configuring the Printer 
Use the following procedure to configure the printer on each laptop. 

1. Select Settings, then Printers from the Start menu. 

2. Select Add Printer. 

3. Click Next. The first screen of the Add Printer Wizard, Local or Network Printer, appears. 

 
Figure 10: Local or Network Printer Screen 

4. Select Local printer. Make sure that the Automatically detect and install my Plug and Play printer checkbox is not checked. 

5. Click Next. The second screen of the Add Printer Wizard, Select the Printer Port, appears. 
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Figure 11: Select the Printer Port Screen 

6. Select Create a new port. 

7. Select Standard TCP/IP Port from the Type drop-down list. 

8. Click Next. The Add Standard TCP/IP Printer Port Wizard appears. 

9. Click Next. The first screen of the Add Standard TCP/IP Printer Port Wizard, Add Port, appears.  

10. Enter the IP address of the printer in the Printer Name or IP Address text box. 

11. Enter the port name in the Port Name text box. The screen should look similar to the following.  Note:Adjust the IP address to match the IP 

address provided by your Stadium Network Engineer: 
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Figure 12: Add Port Screen with Address and Port Name  

12. Click Next. The final screen of the Add Standard TCP/IP Printer Port Wizard, Completing the Add Standard TCP/IP Printer Port Wizard, appears. 

13. Click Finish. The first screen of the Add Printer Wizard appears. 
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Figure 13: Add Printer Wizard Screen 

14. Select the printer manufacturer and the printer from the appropriate text boxes.  HP LaserJet 2100. 

15. Click Next. The second screen of the Add Printer Wizard, Name Your Printer, appears. 
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Figure 14: Name Your Printer Screen 

16. Enter the name of your printer in the Printer name: text box.  Name your printer:  GSIS HP LaserJet 2100.  Select No for the default printer.   

 

Important:  do not set the default printer in this dialog.  If you do, it will not be the default printer for all users. 

17. Click Next. The second screen of the Add Printer Wizard, Printer Sharing, appears. 
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Figure 15: Printer Sharing Screen 

18. Make sure that Do not share this printer is selected. 

19. Click Next. The third screen of the Add Printer Wizard, Printer Test Page, appears. 

20. Select Yes to print a test page. 

21. Click Next. The final screen of the Add Printer Wizard, Completing the Add Printer Wizard, appears. 

22. Click Finish. The following prompt appears when the system sends a test page to the printer. 

23. Follow the instructions on the prompt. 

 


